ECO GUIDE TO

Importing an Existing Inventory
If you have decided to conduct a complete inventory, you will be collecting data for all of the
trees located in your study area. Do you have an existing inventory? If so, you now have the
option to analyze that inventory by importing the data into Eco following the procedure outlined
below.

Formatting Your Existing Inventory
First, you will need to format your existing inventory. i-Tree Eco’s inventory import tool works
best with a properly formatted dataset. This means that existing data should be saved as a
specific file type and include all of the required variables. Each individual data variable also has
its own formatting requirements that must be adhered to.

What file type is best?
Save your inventory data as one of the following file types:
•

Excel spreadsheet (.xls or .xlsx)

•

Access database (.mdb or .accdb)

•

Comma separated values (.csv)

What data are required?
i-Tree Eco v6.0 has been modified so that users are now required to collect only two
measurements of trees to complete an Eco project. The reduction in required data has been
made to accommodate users with existing street tree inventory data, which oftentimes does not
include all of the previously required tree measurements.
The following two data variables must be included in your existing inventory:
•

Species: The species and genus names of each tree assessed.
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•

Diameter at breast height (DBH): The tree stem diameter at breast height (4.5 feet
above the ground) for each tree.

!

Caution
i-Tree Eco requires users to collect two tree measurements. While this
approach allows users with limited existing inventories to run the model, it
also has substantial limitations. The accuracy of ecosystem service
estimates can be improved significantly by providing additional optional tree
measurements.
Please read more about these data limitations in the Eco Guide to Data
Limitations.

For users collecting dead trees, an additional data variable is required for your existing
inventory. Users must collect:
•

Crown health: Tree crown health estimated as condition or dieback (i.e., dead
branches) of the crown.

The crown health variable is used to indicate which sampled trees are dead and which are not.
Dead trees should be given either a 100% dieback or 0% condition designation depending on
which variable you decide to provide. See the Eco Field Manual for additional information on
collecting crown health and designating dead trees in the field.
Be aware that some additional analyses require certain data to be collected beyond species
and DBH. Please refer to the Eco User’s Manual for more information on the data
requirements for supplemental analyses.

How do I format each data variable?
In addition to the two required data variables (species and DBH), users are allowed to import
any or all of the inventory data shown in Table 1. Each individual data variable has its own
formatting requirements.
Here are several guidelines to keep in mind:
•

Field names – Users are not required to edit the field names of their existing data to
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match those used by the Eco application; instead, users will be asked to indicate the
corresponding Eco field name. (Note: Those Eco field names will continue to be used
and displayed in the application.)
•

Data limits – Eco has rules that serve as data integrity checks which require all values
to fall within the accepted limits. For data variables where this applies, the limits are
included in Table 1. The import function will not work properly if the data do not adhere
to the validation rules.

•

Field type – Eco data variables can often be displayed in several ways. For example,
species data can be entered as common name, scientific name, or species code. For
data variables where this applies, users will be asked to indicate which field type
corresponds to their existing data.

•

Value mapping – Users are not required to format their field values to match those
used by the Eco application. For example, if you have recorded your species data as
species codes, these codes do not have to be the same ones that are built into the Eco
application. However, they must be mapped to Eco’s values. The option to map values
is available for all data variables in Table 1. For variables where field values are to be
mapped, the data formatting in Table 1 need not be followed. Instead, users will be
asked to map the values used in their existing data to those available in Eco. (Note:
Those Eco values will continue to be used and displayed in the application.)
Tip
Use the Eco Field Guide to see how data are collected for Eco. This
documentation will help you decide how to match your field names, field types,
and values to Eco’s.

Table 1—Data Variables for Complete Inventory Projects

The Data Variables column lists the required and optional data variables that can be imported
from an existing inventory. For best results, the data formatting and limits described for each
variable should be adhered to unless you choose to map values.
Data Variables

Data Formatting

Data Limits

Required fields
Species
DBH
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Enter as specified in Eco Field
Manual
Enter as number

n/a
0.5 to 500 inch

Optional fields
Tree ID
Strata
Crew
Survey Date
Status
Land use
Photo ID
Latitude
Longitude
DBH measurement height
DBH measured
Street tree/non-street tree
Public/private
Total tree height
Height to live top
Height to crown base
Crown
size
Crown width
Percent crown missing
Crown health
Crown light exposure

Enter as number
Enter as specified in Project
Configuration
Enter as text
Enter as date/time
Enter as specified in Eco Field
Manual
Enter as specified in Project
Configuration
Enter as text
Enter as GPS coordinate
Enter as GPS coordinate
Enter as number
Enter as Yes (Y) or No (N)
Enter as Yes (Y) for street tree or No
(N) for non-street tree
Enter as Yes (Y) for public tree or
No (N) for private tree
Enter as number
Enter as number
Enter as number
Enter as number
Enter as number
Enter as specified in Project
Configuration
Enter as number

Direction

Enter as number

Distance

Enter as number

Energy

Maintenance recommended
Maintenance task
Sidewalk conflict
Utility conflict
Pests (IPED)
User ID
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Enter as specified in Project
Configuration
Enter as specified in Project
Configuration
Enter as specified in Project
Configuration
Enter as specified in Project
Configuration
Enter as specified in IPED Field
Manual
Unique tree ID created by user

> 0 without duplication
n/a
n/a
n/a
n/a
n/a
n/a
n/a
n/a
0.1 to 6 feet
n/a
n/a
n/a
0 to 450 feet
0 to 450 feet
0 to 450 feet
0 to 300 feet
0 to 100 percent
n/a
-1, 0, 1, 2, 3, 4, or 5
1 to 360 degrees
(must be -1 when no
building is present)
0.1 to 60 feet (must be
-1 when no building is
present)
n/a
n/a
n/a
n/a
n/a
number, letter, symbol

!

Caution
Required fields, species and DBH, must be entered according to the
formatting requirements in Table 1 or mapped to Eco’s values. Invalid or
unmatched values will result in records being skipped.

Using the Complete Inventory Import Function
Having properly formatted your existing inventory, you will now import your existing data into a
new or existing Eco project. To begin, click on your computer’s Start button > (All) Programs
> i-Tree > i-Tree Eco v6.
To create a new project:
1 Click File > New Project.
2 In the New Project window, select “Complete Inventory” from the project type dropdown list in the upper right-hand corner.
3 Click OK.
4 In the Save Project File As window, browse to the folder where you would like to save
your project.
5 Enter a file name in the space provided.
6 Click Save.
After you create a new project, you will see that the Eco application automatically opens the
Project Definition function of the Project Configuration tab. Configuring your project is one of
the first things that you do when you create an Eco project. This allows you to provide the Eco
application with important information, such as what type of project you will be doing, where
your study area is located, and what data you will be collecting. For a complete inventory
project where you are importing existing data, all of the information that you provide here should
apply to your existing dataset.
To configure your project:
1 Click on the Project Configuration tab.
2 Click on the Project Definition function.
3 Work through the Project Settings, Location, and Data Collection Options tabs from
left to right.
4 Close the Project Definition function when you are finished by clicking on the OK
button in the upper right-hand corner to save your settings.
5 Work from left to right through the Project Configuration tab to provide additional
information for the functions that are relevant to your project.
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Tip
While working in Eco, use the on-screen help text in the panel on the lefthand side of the window. This help text will provide step-by-step directions
for using each button and function.

Tip
Several of the Project Configuration functions allow users to define their
own field values. For example, management fields, such as sidewalk and
utility conflicts, can be customized so users can define the fields that are
relevant to their project goals. Where possible, define the data fields that
you will be importing from your existing data.
To import your existing inventory:
1

Click on the Data tab.

2

Click on the Trees function. (Note: The Import tool will become available in the ribbon.)

3

Click on the Import tool to import your existing tree inventory.

4

In the Data Import Wizard, click Browse.
a
b

Navigate to the file containing your inventory data.
Select the file and click Open.

5

Check the box to signify that the first row of your dataset contains the column headers.
Otherwise, leave the box unchecked.

6

Confirm that the data that appears in the table is correct and click Next.

7

Match your existing data fields to Eco’s data fields.
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a

Select an inventory column from the table. The column header will appear in the
“Your Source Column” space towards the bottom of the window.

b

Choose the “Eco Field” from the drop-down list that defines the type of data in
your selected column.

c

Check the box indicating whether or not you will need to map your field values to
the Eco field values. (Note: You will be prompted to complete the value mapping
later. See step 9 below.)

d

CONDITIONALLY REQUIRED: As previously described, Eco data variables can
often be displayed in several ways. For example, species data can be entered as
common name, scientific name, or species code. For data variables where this
applies, a “Field Type” drop-down list will appear below “Eco Field.” Select the
field type that matches your existing data.

e

Repeat steps 7a through 7d until each variable that you would like imported has
been matched to the appropriate Eco field.

Tip
Try moving from left to right, clicking on each column in turn. This can help
ensure that you match all of the necessary columns to an Eco field.
8

Click Next.

9

CONDITIONALLY REQUIRED: For data variables where you indicated the need to map
field values (in step 7c above), match your field values to Eco’s.
a

In the upper table, select a row.

b

In the lower table, choose the “Eco Value” from the drop-down list that matches
“Your Value.”

c

Move through the lower table until all of your values have been matched to an
Eco value.

d

Repeat steps 9a through 9c until all necessary data variables have been
mapped.

10 Click Next.
11 Review the results of your processed data at the top of the Data Import Wizard. This
information will tell you how many records from your inventory data will be imported.
12 When you are satisfied with the data that will be imported, click Finish. (Note: Use the
Back button to return to previous steps for any adjustments.)
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After you have completed importing your existing inventory data, you will be able to make use of
the Eco application as described in the User’s Manual. Use the Data tab to view or edit your
data, edit benefit prices, or add annual costs; the Reports tab to submit your data for
processing, retrieve your results, and view the results of your Eco run; the Forecast tab to
model future scenarios for your urban forest; or the Support tab to make use of i-Tree’s support
materials.
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